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Goals

Customer Training Material

* In this workshop, you will model
the heat dissipation from a hot
electronics component fitted to a
printed circuit board (PCB). Heat is
dissipated via a finned heat sink

* The PCB is fitted into an enclosure
which is open at the top and
bottom

- Initially only the heat transfer via

convection and conduction will be >T
calculated. The effect of thermal iy 000
radiation will then be included as a

later stage
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M es h I m p o rt (Wo rk be n c h ) Customer Training Material

« This workshop can be done either inside or outside of ANSYS
Workbench.

If working with FLUENT within Workbench

Open a new Workbench session and select a new FLUENT session
from Component Systems

e Use Save As to save the
session
* Import the mesh file.

— Right-click on the Setup cell
— Click on “Import FLUENT Case”

— Change Files of Type to FLUENT >
Mesh File g8x WL;:;“
— Select the mesh file heatsink.msh.gz - =
— Click Open =
 Launch FLUENT using the o 2
default options 3

ANSYS, Inc. Proprietary Release 13.0
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Mesh Import (Stand-alone)

Customer Training Material

If working with FLUENT as Standalone

straight FLUENT

° Start a 3D FLUENT session from File | Mesh Define Solve Adapt Surface Display Report
the icon or from the Windows Start Read Pl Mesh., S
menu Write ] Case... B

Import 3 R B
T . Case & Data... -
« Select either Export to CFD-Post... PDF... b
. . . ISAT Table...
— File > Read —» Mesh from the top olution Files.. ——_— 1
Interpolate... T =
menu - - EM Mapping . View Factors... n
— Open File icon from toolbar and ESI Mapping b Profile...
seIeCt meSh Save Picture... Scheme..
Data File Quantities... Journal...
Batch Options... - =
RSF... pipe-0000
Exit pipe-par B
Plots o pipe
* Open the file heatsink.msh Reports

ANSYS, Inc. Proprietary Release 13.0
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View the model:

NANSYS

Customer Training Material

« Check the mesh (from General tab).

— Review the text in the lower FLUENT
window and check there are no errors

'|D

-
Mesh Display

Surfaces

interior-fluid
interior-solid_board
interior-solid_heatsink

Options Edge Type
[ Modes @ all
Edges @) Feature
Faces () Outiine
|| Partitions

Shrink Factor ~ Feature Angle

| 20

- Display the mesh and adjust the
display settings

Under Graphics and Animations select Mesh
Set Faces to on, and Edges to ‘Feature’
Deselect all currently selected faces

Select Surface Types Pressure
Outlet, Velocity Inlet and Wall, (note effect on

Surfaces list)
Select Colors and Color by ID, Close

Click Display

. Dlsplay Lights and turn on the headlight

ANSYS, Inc. Proprietary

Surface Name Pattern

Surface Types E] E]
\

interior-solid_heatsource

wall_board-heatsource

symmetr
velodty-inlet
wall
zone-surf

'

[Display] [Colors...] [ Close ] [ Help ]

Problem Setup

Graphics and Animations

General

Models

Materials

Phases

Cell Zone Conditions

Boundary Conditions

Mesh Interfaces

Dynamic Mesh

Reference Values
Solution

Solution Methods

Solution Controls

Monitors

Solution Initialization

Calculation Activities

Run Calculation

Graphics

Contours - Unavailable
Vectors - Unavailable
Pathlines - Unavailable
Partide Tracks - Unavailable

Animations

Sweep Surface - Unavailable
Scene Animation
Solution Animation Playback

| Results
Flots
Reports %
[ Scene... ][ Views... ]
Lights... olormap. .. ][Annotabe... ]
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Model setup

NANSYS

Customer Training Material

Set Units
- Change temperature units to °C Quantiies
. . specific-heat
Define — Units stefen boltznann-<onstant (s
. surface-tension
— Select Temperature as a Quantity B L S |
. temperature-inverse -
— Select “c” as the temperature units e i e
— Close the panel thermapher et affusiity Offset [273.15
time i
- [New...] l List ] [Clnse] [Help ]
- Enable the energy equation
— Select the Models tree item Models
— Double-click on Energy and enable Models
. MultlEhase - Off
the equatlon Viscous - Laminar
OR
— Click on Energy and then Edit <Gcaion g -Of
Acoustics -0 rEnerg}r |_23 .

Energy Equation

‘ Energy ‘

‘[ o [aa] (e ]‘

ANSYS, Inc. Proprietary Release 13.0
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Comments on Model setup

Customer Training Material

 General

— It is good practice to display the grid after import to check for any
boundary zone miss assignment and that you have opened the correct
model

— Workbench uses Sl units (metres, kg etc) but if importing a mesh from
another source check the scale and dimensions are correct

— Check mesh is used to confirm the mesh is suitable for use in a CFD
simulation

— Report Quality is a backup to the quality tools available within the
meshing application

- By default the energy equation is not solved to reduce CPU load
because many problems are isothermal. In this case, temperature
must be calculated so the energy equation needs to be enabled

* The onset of turbulence is specified by the Reynolds Number (pipe
flow) or Rayleigh Number (natural convection). Calculating these
numbers for this geometry and conditions indicates that the flow will
be laminar and so no change is required to the viscous model

ANSYS, Inc. Proprietary Release 13.0
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NANSYS

Material properties

Customer Training Material

-
Create/Edit Materials

* The air density needs to change with

E
temperature (but not pressure) e e — e |
— Select Materials > Air - Create/Edit

— Change density to incompressible "Q =
ideal gas e o =
— All other properties remain unchanged || =" = E=
— Click Change / Create then close the T e i
fluid materials window e
('3 FLUENT Database Msterils J— )

* Define two additional solid materials
(for the board and the heat sink).

— Select Materials &> Solid &> Create/Edit

. v] View
— Click the FLUENT Database button. =
) Cp (Specific Heat) (jfkg+) [oonstant ,] Viey
— Change Type to Solid - [=
Thermal Conductivity (w/m-) [mnsmnt 'I View

— Select Copper
— Copy then close the database window

ANSYS, Inc. Proprietary
© 2010 ANSYS, Inc. All rights reserved.

FLUENT Solid Materials

(=) MaterlalType\

Density (ka/m2) [ constant

|387.6

Electrical Conductivity {1/ohm-m) [ooﬂsmnt

|5.8e+o7
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Material properties

Customer Training Material

* Modify the copper material to produce the PCB material

- The PCB is made Of material r Create/Edit Materials - .":" ‘ Mw
117 F R_4, J T?:: Faberial T ] Ort-:ler Materials by
solid - | | @ MName
) () Chemical Formula
« Change Name to fr-4 i i .| C A osmben. ]
* Delete the chemical formula | Lser 2efned Doanas..
- Density = 1250kg/m3; ¢, = 1300 ==
. - Density (kag/m3) Edit... =

J/kg K; conductivity 0.§5 W/m K : ﬁf;:j"t z)( &
» Click Change/Create. Cp GpestctientOh) [ s
* Click No when prompted to [0

. \ Thermal Conductivity {w/fm-k) =
overwrite ﬁj”;j”t 7l et
copper.

— Selecting No will create a new |
material fr-4, but copper remains in
the material Iist | [ChangefCreahe] [ Delete ] [ Close ] [ Help

— Selecting Yes would overwrite the
copper material for the current case
only (it’s still in the database)

- Again, modify the copper material to create the “component” material
using the steps above

— Density = 1900 kg/m?; ¢, = 795 J/kg K; Thermal Conductivity = 10 W/m K
* The heat sink is made of copper

ANSYS, Inc. Proprietary Release 13.0
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Comments on Material properties

Customer Training Material

* In most natural convection problems the change of density with
temperature drives the flow. The changes in pressure over the
domain are minimal, and their effect on density negligible, hence the
incompressible ideal gas density formulation can be used instead of
the fully the compressible ideal gas model

- The FLUENT database contains basic properties for many materials.
These are generally set to the standard STP/RTP values, but always
check these are suitable before proceeding

« Additional materials can be added to the database; refer to the user
documentation. It is often easier to copy a material from the
database and then modify it; alternatively, you can modify the default
material of aluminium and then choose not to overwrite

ANSYS, Inc. Proprietary

© 2010 ANSYS, Inc. All rights reserved.
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Set Cell Zone Conditions

NANSYS

* Under Cell Zone Conditions click the
Operating Conditions button.

— Enable Gravity, and set the y component
to -9.81 m/s?

— Turn on Specified Operating Density and
set to 1.11 kg/m3

— Click OK

- There are no changes to the fluid zone
— (Cell Zone - Fluid -> Edit)

— Observe that this contains material air
which is correct.

— Close the pop-up window

ANSYS, Inc. Proprietary

© 2010 ANSYS, Inc. All rights reserved.

Customer Training Material

-
Operating Conditions

Pressure

Gravity

Operating Pressure (pascal)
| 101325 &

Reference Pressure Location
(®)
Y (m) | o
(®)
Z(m) | 0
(®)

Gravity

Gravitational Acceleration

% (mfsZ) | 0

¥ [lTlJrSZ} | 881

Z (mfs2) | 0

Boussinesq Parameters

Operating Temperature (c)
| 15.01001 &

Variable-Density Parameters

Specified Operating Density
Operating Density (kg/m3)
| 1,183975 B

[ 0K ] [Cancel] [HE||:I ]

Release 13.0
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Set Cell Zone Conditions

- Set the material properties for
the PCB: r Salid M‘

Zone Name

— Select cell zone solid_board, and | [

NANSYS

Customer Training Material

- Material Name [ g_a - &]
E d It [T]Frame Moh':[:n [ source Terms ]
. |:| e otion |:| ixed Values
- C h a n g e th e m ate rl a I to fr-4 RZFEZ:OEUFFEH'IE | h:eshdh:o:jon | Source Terms I Fixed Values I
. O K to C I ose th e wi n d oW Rotation-asxis Origin Rotation-Auis Direction

X (m) lui [mnsmnt v] X loi [cons'ﬁnt v]
Yo [constant W] Yo [constant -
» Set the material properties for I = INE — 2

the heat sink: |
— Heatsink is made of copper

— Select the cell zone )
solid_heatsink Co] (caet) [

— Change the material to copper

ANSYS, Inc. Proprietary Release 13.0

December 2010
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Set Cell Zone Conditions

NANSYS

* Set the conditions for the
component:

— We need to set both the material,
AND the thermal power (75W)
dissipated by this component

— Select zone solid_heatsource
— Change the material to component

— Check Source Terms then go to the
Source Terms tab

— The component volume is
0.11808x10-3 m3. Hence, the
volumetric source is 635,000 W/m?3

— Create 1 constant energy source
with the above value

ANSYS, Inc. Proprietary

© 2010 ANSYS, Inc. All rights reserved.

Customer Training Material

-

Solid

Zone Mame

| solid_heatsource

Material Name [mmponent

~ | [Edit...

|| Frame Motion [V Source Terms
[ Mesh Motion [ Fixed Values

Reference Frame ] Mesh Motion ~ Source Terms l Fixed Values l

Energy (w/m3) | Tere

r ™
Energy (w/m3) sources ﬁ
Mumber of Energy {(w/m3) sources [ { %

L ‘ 35000

constant

a ||

[ QK ] [Can::el] [Help ]
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S et B o u n d a ry C o n d i t i O n S Customer Training Material

* For the Inlet (Boundary Conditions - Inlet)
— Change type to Pressure Inlet
— Keep the pressure at 0 Pa

Zaone Name
| inlet

Momentum  Thermal |F‘.adiaﬁon| Speciesl DPM I Mulﬁphasel uDs |

Total Temperature (c) | 45 [mng*@nt - ]

[ (0]4 ] [Cancel] [Help ]

* For the Outlet:
— Keep type as Pressure Outlet
— Set 0 Pa Gauge Pressure

— Change Direction to “From Neighbouring Cell”
— Under the Thermal tab set Backflow Total Temperature to 45°C, then OK

ANSYS, Inc. Proprietary Release 13.0
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S et B o u n d a ry C o n d i t i O n S Customer Training Material

- Set the casing walls to be adiabatic:
— Select boundary zone wall_left
— Under the thermal tab, check this is set to zero heat flux
— Repeat for wall_right and wall_top

- Set the PCB outer surface thermal properties to be adiabatic.
— These are the external surfaces of the model
— The surfaces to set are wall_board_bottom and wall_board_side
— Set these to zero heat flux as above.

— Note that the surface wall_board is the surface of the PCB that borders
the fluid air region, and so is not an exterior boundary

ANSYS, Inc. Proprietary Release 13.0
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NANSYS

Customer Training Material

Comments on Cell and Zone Conditions

« Operating conditions

— Gravity is required for natural convection. In many
cases there are no gravity effects, and the option can

-—-——
B BT
—

File Mesh Define Solve Adapt Surface Display Report  Parallel

Er-d-me| ([Geaa ) @ nE-O-

. . - Problem Setup Reports
remain inactive General
Reports
Model_s Fluxes
Materials

— Operating density is critical in natural convection
problems, and should be set to the density at the far
field temperature (i.e. inlet temperature)

— Operating pressure position is related to the
inlet/outlet pressure settings. In this example,
it is positioned at the inlet

Phases

Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values

é

Histogram
Summary - Unavailable
Heat Exchanger - Unavailable

Solution

Solution Methods
Solution Controls
Monitors

Solution Initialization
Calculation Activities
Run Calculation

- Boundary zones et somenrs | e
raphics and Animations SetUp... | | Parameters...
— Inlet and Outlet pressure set ( e )
[Help |

to 0 Pa gauge, as it is at the
operating pressure position

rg Volume Integrals ﬁ
® VOI u m e d ata Repart Type Cell Zanes BIE|
. [ | Mass-Average Fressure,.. fluid
- The VOI U me Of a n e ntlty Ca n be :L?: Int=gral Static Pressure Qlé P:Eatr:ource

sglid heatsink

reported from the Volume Integrals | _ ‘oo F*;‘;;‘ul::;mﬂh
panel. Note that the solution must (2™ ) [
erage | | Save Output Parameter...]

() Volume Integral

be initialized before the volume
integrals are enabled

[Cornpute] [Write...] [ Close ] [ Help ]

ANSYS, Inc. Proprietary

Release 13.0
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Comments on Cell and Zone Conditions T e

- External heat loss:
— Here, adiabatic conditions have been set for the external walls.
— However if needed, FLUENT can model the external boundary in several
different ways, including:
* Known heat flux (W/m?)
* Known heat transfer coefficient (eg for natural convection from a vertical plate)

* Heat transfer through radiation (by setting emissivity and temperature). Note
this is not related to radiation models available within FLUENT

« Shell conduction in the outer wall (hence fields for material and wall thickness)

* Interior boundaries:
— In this example, there are four cell zones; including fluid and solid_board

— Just one label wall_board was created at the pre-processing stage for the
surface common to these two zones

— When loading the mesh, FLUENT creates a clone: wall_board_shadow
— Open up the boundary conditions for these surfaces and observe that:

- wall_board has the adjacent cell zone fluid
- wall_board_shadow has the adjacent cell zone solid_board

— If setting emissivity or roughness, make sure the correct face is selected!

ANSYS, Inc. Proprietary Release 13.0
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NANSYS

Solver controls

Customer Training Material

* Solution Methods - Spatial Discretization - Pressure
— Change the pressure scheme to Body Force Weighted
— Leave the remaining variables set to First Order Upwind.

* Solution Controls 2> Momentum

— Adjust the Momentum under-relaxation factor to 0.3
 Solution Initialization e
— Compute from inlet teot

— Set y-velocity to 0.1 m/s

~ Click the Initialize button - (&

|
* Run calculation

1e-07

— Set for 150 iterations and B ™ T il
click Calculate.

— The solution should only 5-10 minutes to complete

— Note, a fully converged cas & dat are in the tutorial folder
(ws4_no-radiation.*.gz)

ANSYS, Inc. Proprietary

1e-02 |
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Comments on Solver controls

Customer Training Material

* The solver settings are tuned for an overall robust solution of most
situations. In this model we require the Body Force Weighted pressure
scheme to account for the natural convection effects

* Once the solution has begun to, or has converged, the momentum and
energy equations should be switched to second order to improve the
accuracy of the solution. You may wish to do this later if time permits

* The momentum within the model is relatively low so reducing the
momentum under-relaxation factor is recommended

- Solution initialization is used to provide the first guess prior to the first
solver iteration; and it should be as close to the final solution as
practical

* In this model convergence cannot easily be measured using the
residuals. Typically mass conservation and monitor points would be
used to ensure the solution has stopped changing

ANSYS, Inc. Proprietary Release 13.0

© 2010 ANSYS, Inc. All rights reserved. December 2010



WS4: Electronics Cooling AN SYS

Quick post-processing

-

Customer Training Material

* Check overall heat and mass balances.
— Reports 2 Fluxes = Set Up
— Select the Inlet and Outlet surfaces, then click Compute.

* The net imbalance mass flux is shown under Net Results
* Note that the net imbalance is very small relative to the boundary mass flow

— Switch to Total Heat Transfer Rate. Select all walls, the inlet, and the
outlet and click Compute.

* Note that the difference equals the energy source input to the package (75W)

-
Flux Reports - — ﬁ Flux Reports - — ﬁ
Options Boundaries [E] (5] Resulis Options Boundaries [E] [5] Resulis
© Mass Flow Rate 0.0085768215575285¢ ~ (©) Mass Flow Rate (e . | |7 6702t -
(") Total Heat Transfer Rate ?nir?or—ﬁuli_dd board i (@) Total Heat Transfer Rate !nir!or-ﬁul[dd board o
: . interior-solid_boar Y D it interior-solid_boar
"I Radiation Heat Transfer Rate interiorsolid_heatsink _) Radiation Heat Transfer Rate interior-salid_heatsink
interior-solid_heatsource interior-solid_heatsource
Boundary Types EE (P =||[-0.0088775074109435 = Boundary Types EE (P £ || ||-253. 7899627685547 | =
axis » | |[wall_board axis » | |[wall_board
exhaust-fan M wall_board-heatsource exhaust-fan 1 wall_board-heatsource
fan —'| |lwall_board-shadow fan —'| |lwall_board-shadow
inlet-vent = | ||wall_board_bottom — B inlet-vent = | ||wall_board_bottom
wall_board_side wall_board_side
wall_heat_sink wall_heat_sink
Boundary Name Pattern wall_heat_sink-shadow Boundary Name Pattern wall_heat_sink-shadow
Ii wall_heat_source 5 8 ’7 wall_heat_source 5 8
| m | 3 1| m | 3
[Save Qutput Parameter. .. ] Met Results (kafs) | [Save Qutput Parameter... ] Met Results (w) i
| 6.8545342-07 | -75.11206
Compute | [ Write. .. ] [ Close ] [ Help ] i Compute | [ Write... ] [ Close ] [ Help ]
b

ANSYS, Inc. Proprietary Release 13.0
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Save Case and Data Files for Later Use S

* The purpose of the Workbench structure is to simplify the file structure, and
reduce the risk of stray files on the hard drive

« Part of this workshop is to allow the comparison of the results both with and
without radiation active. To retain this set of results use the top menu to:
— If using FLUENT standalone 3 AFLUENT FLUENT 33, pbns,lam) (FueniL v AR
. File SWrite > Case & Data. .. [File| Mesh Define Solve Adapt Surface Display Report Parallel V

Refresh Input Data L A E L EyO -
— If using FLUENT under Workbench save Project [
* File 2Export 2> Case & Data...

s and Animations

Read 3
Write »

Import 2

Export » Case...

— Change to the working directory and label the

file Iogica"y Solution Files... Data...
Interpolate... Case & Data...
EM Mapping y PDF..
FSI Mapping v ISAT Table...
) TIP Flamelet...

Save Picture...

Data File Quantities... Sias s

— Adding the .gz extension will compress

. . Profile...
the case and data files, reducing hard CloseFLUENT | e
. —
dISK usage EE;[LS @ Solution Data...
— You do not need to uncompress the el
files when opening them later LOgton,  puring Calcultion '
Lights... [[Colormap... || Annofate... |

ANSYS, Inc. Proprietary Release 13.0
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Set u p Ra d I atl o n M o d e I Customer Training Material
- The temperature difference across the air space ]
is notable, and therefore heat transfer via S
thermal radiation may be significant e
- Go to the Models tree item and select radiation. 7
— Enable the Surface-to-Surface (S2S) model
— Click the Settings button to define model ,
parameters O oo tratanen
* Manual Options ' |
+ 1 Face Per Cluster and Apply to All Walls R e e =

Clustering

+ Select Face to Face as the Basis and the Ray Tracing
Method

« OK
— Either click on the Compute/Write/Read button
* Enter a filename. Calculating and writing the view

factors will take a few minutes < od
— Or click on Read Existing File and load j=—— ‘“"
ws4_viewfactor.s2s.gz (recommended) Smam | [l S
* Click OK when the S2S view factor step is 9 :,5_
complete e, (o

ANSYS, Inc. Proprietary Release 13.0
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Comments on S2S Radiation model S

* The model uses a ray tracing method, and this calculation is
completed prior to the main solution. Thus, whilst the set up time is
slightly longer due to the calculation of the view factors; the overall
solution time is lower when compared to alternative radiation models
available within ANSYS FLUENT

 The method determines the view factor from each wall (or boundary)
surface facet (mesh cell) to every other facet. Clustering is used to
reduce the number of facet calculations needed in the actual
solution. Neighbouring facets are grouped together based on the set
values and other geometric factors

* The User documentation contains full details of the model

ANSYS, Inc. Proprietary
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Revise Boundary Conditions

Customer Training Material

* The surfaces surrounding the fluid region now also require an
emissivity value for the radiation model

* Open the wall_left boundary condition and under the thermal
tab change the Internal Emissivity to 0.9

* Click the Copy button and copy the boundary conditions to
wall_right and wall_top

B wa - . - o Copy Conditions — ﬁ

Zone Name

|wa||_|eft From Boundary Zone To Boundary Zones @ E]
Adiacent Cell Zone wall_bnard__mde + | [wall_board_battom
|ﬂuid l.r-.'all_heat_s!nk wall_board_side
wall_heat_sink-shadow wall_right
Momentu Jadiation | Species| DPM | Multiphase| uDs | wall_heat_source wall_to
wall_heat_source-shadow F
Thermal Conditf wall heatennrce-heataink -
@ Heat Flux Heat Flux {w/m2) [ [mnsiﬁnt v] wall left ‘5‘
() Temperature : : |
Con\?:cﬁon @ [COHSEI"It v] :,:::_E;t -
() Radiation =

() Mixed Wall Thickness (m) | 0

Material Name Heat Generation Rate (w/m3) | 0 [consiﬁnt ,] l
[aluminum vl Edit...

[Copy | [CInse] [Help]

[ shell Conduction

[ oK ] [Cancel] [Help ]

ANSYS, Inc. Proprietary Release 13.0
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Revise Boundary Conditions

NANSYS

- Change some of the other internally
facing walls (wall_heat_sink and
wall_board) to have an emissivity of 0.9

- Change wall_heat_source-shadow to
have an emissivity of 0.3
* Note these panels are slightly different to
those in the previous slide as these are

coupled walls — that is they do not make
up the outer boundary of the domain

* The flow boundaries (inlet and outlet)
can be left with an emissivity of 1

- Solve the flow field again (this time with
radiation enabled) for a further 500
iterations. If you are short of time you
may want to stop the solution
prematurely and proceed to the post-
processing

ANSYS, Inc. Proprietary

Customer Training Material

-
Wall -

—

Zone Name
| wall_heat_sink

Adjacent Cell Zone
| fluid

Shadow Face Zone
| wall_heat_sink-shadow

Momentum Thermal IRadiaﬁon} Speues] DPM ]Mulhphase] uDs I

Thermal Conditions

() Heat Flux
() Temperature
@) Coupled

Internal Emissivity | 0.9

aterial Name Heat Generation Rate (w/m3) [ |

constant -
Wall Thickness (m) [

[ shell Conduction

i - ™y
Pressure Inlet &J
Zong Name
|inlet
Momentum | Thermal Radiation ] Species] DPM ] Mulﬁphasel ups l
External Black Body Temperature Method [Eoundary Temperature - l
|
Internal Emissivity | q| ’mns,ﬁnt ,]
L
Participates in View Factor Calculation
[ox | [Concdl] (el ] H
I
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Post-processing using CFD Post R —————

* Post-processing can be done either in FLUENT or CFD Post
— Both methods have their advantages

— In this tutorial we are going to take advantage of CFD Post’s ability to
compare two models simultaneously

* Workbench
— Choose a Results component from the Component Systems in Workbench
— Connect the FLUENT solution panel to Results

— Open the Results; this opens CFD Post with the result of the radiation
calculation as labelled as FLU

- Standalone
— Start CFD Post from the menu system/icon

* Fully converged cas & dat files are available within the Workshop 4
folder

— If using the Workbench route, drag a Results icon onto the worksheet
— Right click and edit the cell and follow the standalone notes

ANSYS, Inc. Proprietary Release 13.0
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Case Comparison — Within Workbench ST e
* The case comparison tool allows two different setups to Cse options
be shown side by side and any differences between the [ Keep asrent cases oaded
two cases identified S

[ Edit case names

Additional actions

- We will compare the latest results (with radiation) with
those saved earlier (no radiation)

[7] cClear user state before loading
Maintain camera position
Load partide track data

* File 2 Load Results and select the non-radiation case
saved earlier. Select Keep Current Cases Loaded, then

Open 34 2 A
* From the toolbar, select the Case Comparison Icon: o
* In the Case Comparison details

— Check the box “Case Comparison Active” and check that: oes: e case comparson
- - Definition
— Case 1 is the most recent results FLU (with o
rad i at i o n) Case 1 {ws“l_no radiation - %
Case 2 ws4_radiation -
— Case 2 is the file saved earlier (no radiation) T
Synchronize camera in active views
- Apply. [] Use absolute value of Difference
Mesh Detection | Auto-detect same mesh -

* Press Apply to enter comparison mode

ANSYS, Inc. Proprietary Release 13.0
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Case Comparison — Outside Workbench SIS T e
* The case comparison tool allows two different setups to Cose options
be shown side by side and any differences between the e o
two cases identified s
- We will compare the latest results (with radiation) with - e ranes
those saved earlier (no radiation) Aditonal actons

[7] cClear user state before loading

Maintain camera position

File 2 Load Results and select the non-radiation .dat file
saved earlier

Repeat the Load Results but read in the radiation results
and “Keep current cases loaded”

From the toolbar, select the Case Comparison Ilcon

Load partide track data

Details of Case Comparison

Press Apply to enter comparison mode ] Case Conparon Actve

Case 1 [ws4_no radiation - ]

Caze 2 [ws4_radiation - ]

Options
Synchronize camera in active views
[ Use absolute value of Difference

Mesh Detection | Auto-detect same mesh -

ANSYS, Inc. Proprietary Release 13.0
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NANSYS

Displaying Temperature

- Temperature will be a key
variable for any electronics
cooling application so it will be
displayed in several locations,
such as within the flow, on the
surfaces of the solid region
and by extracting the
maximum temperature within
the component

 Create a YZ plane using
Insert>Location>Plane:

— Call it Centre
— Located at X=0

— Colour it using the variable
Temperature.

e S
Seggion | Imgert | Tools Help

g fe 'ﬂ Location
Variables qg Vector

es Contour
Streamline

=
& fuid a Partide Track
ﬂ Volume Rendering

ANSYS, Inc. Proprietary
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Customer Training Material

Viewl v Case 1 (ws4_no radiation) ~ 0 View2 v Case 2 (ws4_s2s radiation) ~ 0

0.300 (m)

0.150

ANSYS

-1.401e+001

0 0.350 0.700 {m) \d ¥
B .. %

0.175 0.525
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D is p I ayi n g Te m pe rat u re Customer Training Material

* Create a contour plot: Geametry | L[bels [ Render | ven | ]
. Domains All Domaing - ||
- Use elther Insert 9 Contour Locations Fvall_board,waII_heat_sink,wall_heat_source v%~>
or click on e ——t Pl
— Use the fluid-solid interfaces Rnge  [Gabal <]
as the location (wall_board , pin @L;”T“""Sem _
wall_heat_sink and M | e
wall_heat_source). Multiple R Nk 1
= View2 - Case 2 (wsd_s2s radiation) < outlet

locations can be selected by
clicking |[..| and holding
CTRL (select surfaces from
both sets)

— Set the variable to
Temperature using the
Global Range, and Apply

| ¥ wall_board |

[+ wall_board heatsource solid_...

[+ wall_board heatsource solid_...

P£ wal_board shadow
J£ wal_board_bottom

& wall_board_side

|JE wall_heat_sink |

[+ wall_heat_sink shadow

|P¥ wall_heat_source |

[+ wall_heat_source shadow

[+ wall_heatsource heatsink soli ..

[+ wall_heatsource heatsink soli ..

0 0300 (m) {<V 0 0.300 (m) \Z<:V JE wall_left
0.150 — £ wall_right
J¥ wal_top
4 rad
P& inlet
it outlet

| ¥ wall_board |

m

¥ wall_board heatsource solid_...

i$ wall_board heatsource solid_...
i€ wall_board shadow | 4
i€ wall_board_bottom

fi£ wall_board_side

|PE wall_heat_sink |

JI£ wall_heat_sink shadow 'l

| ¥ wall_heat_source |

¥ wall_heat_source shadow lll |

', z
0 0350 0.700 (m) \<‘: " [ ok ] [ Cancel ]

0175 0.525
e |
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Reporting Temperature

NANSYS

Customer Training Material

« Use the the function calculator using the £
icon on the toolbar.

—  Set the options to maxVal,
solid_heatsource, All Cases, Temperature

* Note that with radiation, the temperature
in the solid is lower than when radiation
was not included

 The cooling of the component is mirrored
with an increase in the temperature of the
walls around the fluid zone. This can be
seen if you plot the temperature on the
walls or use the Function Calculator with
the areaAve function

ANSYS, Inc. Proprietary

Outline I Variables | Exprasslon{l Calculators Durbc |

Ej Mesh Calculator

Function Calculator

Function [max\dal - ]
Location [sohd_heaisource = ] E]
Case [NI Cases = ]
Variable Temperature - E]

Direction Global

Fluid All Fluids

Results

Maximum Value of Temperature on solid_heatsource

Case 1 (ws4_no radiation)
379,981 [K]

Case 2 (ws4_s2s radiation)
367.637 [K]

Maximum Value of Temperature.Difference on solid_heatsource
14.5907 [K]

Clear previous results on calculate
[T Show equivalent expression

Calculate Hybrid Conserva tive

Release 13.0
December 2010
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F I OW D i s p I ays Customer Training Material

* To show the flow patterns a range of methods can be used including
streamlines, vector plots and isosurfaces

* Insert an isosurface using Insert-> Location-> Isosurface and set the
Variable to Velocity with a value of 0.5m/s. Gradually reduce the
value to 0.2 and notice that for the radiation case higher speed flow
can be observed close to the fluid walls as well as thg PCB

View1 v  Case 1 (ws4_no radiation) ~ [ view2 ~ Case2(ws4_s2s radiation) ~

- Insert a vector plot using Insert-Vector e - 1|
or click on z. Set the location to I M I M
Centre. Change the Sampling to Equally i I
spaced with 1000 points. If you wish to ;:_ e ;:— e

see the pattern in the slow speed
sections try going to the Symbol tab
and select Normalize Symbols

ANSYS, Inc. Proprietary Release 13.0
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Summary

Customer Training Material

* In this Workshop you have:

— Seen how FLUENT can be used within and outside of the Workbench
environment

— Modelled a natural convection flow with conjugate heat transfer and
source terms

— Modified/created and used multiple solid materials
— Used the S2S radiation model

— Post processed two results simultaneously and compared the differences

ANSYS, Inc. Proprietary Release 13.0
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